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Outlook – 
Organizing the Inbox 

 
 
 
 
 

 
 
 
 
 

Microsoft Outlook is the most utilized business application in the world today, but for many users dealing 
with Outlook is the most frustrating part of their day. This session is designed to help Outlook users better 
organize and manage their email communications. It contains coverage on how to reduce e-mail 
interruptions, triage the Inbox rapidly, find related messages quickly and easily, organize the Inbox with 
folders, categories, and rules, and use drag-and-drop to create new tasks and appointments. The 
information provided in this session will ease your frustration and improve your productivity in using 
Microsoft Outlook. 
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Take Control of Email 
If you feel that you would get a lot more work done in the office if you didn't have to deal with email, you 
are not alone. Recent research shows that one of the greatest threats to staff productivity is workplace 
distraction, and most users would agree that email is the most significant source of distraction in the 
office.1 What began in the early 1990s as a productivity enhancing application has become a nightmare 
for most business professionals. For many, email consumes more time and effort than almost any other 
workplace activity. Some receive hundreds of messages daily, most of them worthless SPAM. If you want 
to improve your personal productivity and return some semblance of order to your workday, taking 
control of email should be your number one goal. 

 

Reduce Interruptions 
Unfortunately, the default settings in Outlook don't help users achieve that goal. When a message arrives, 
Outlook plays a sound, briefly changes the mouse pointer, shows an envelope icon in the taskbar, and 
displays a desktop alert. No wonder you can't get anything done. No sooner do you start a task than 
Outlook cries out, "You’ve got mail," and the interruptions continue throughout the day. 

 
A better way to handle email is to disable all notifications and check email on a fixed schedule. For 
example, you could check email five times a day – when you arrive at work in the morning, just before or 
after your morning break, lunch, and afternoon break, and just before leaving the office in the evening. 
Interruptions are minimized because email is handled during natural pauses in your workday. Don't worry 
about clients, customers, or managers who demand immediate response to email. Outlook can be 
configured to alert you when messages from specific people arrive even though message notifications 
have been disabled. That is covered in a later section on creating rules to handle in-bound messages. 

 
To disable email arrival notifications, do one of the following. 

 
1. In Outlook 2007, select Tools, Options from the menu. On the Preferences tab, click E-mail 

Options, Advanced E-mail Options to open the Advanced E-mail Options dialog box. Uncheck 
Play a sound, Briefly change the mouse cursor, Show an envelope in the notification area, and 
Display a New Mail Desktop Alert. Click OK to commit your changes. 

 
2. In Outlook 2010-2016, click File, Options to open the Outlook Options dialog box. Click Mail in 

the navigation pane on the left and then scroll to the Message Arrival section in the options pane 
on the right as shown in Figure 1. Uncheck Play a sound, Briefly change the mouse pointer, Show 
an envelope in the taskbar, and Display a Desktop Alert. Click OK to commit your changes. 

 
With that simple change, email interruptions will be banished from your workday. Keep in mind that you 
may suffer withdrawal pains from the respite, so make sure to resist the temptation to check email 
manually until you have become fully accustomed to your new routine. 

 
 
 

1 Dr. Gloria Mark, University of California – Irvine, quoted by Farhad Manjoo, "Discovering Two Screens Aren't Better 
Than One," The New York Times Online Edition, March 19, 2014. 
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Figure 1 - Disabling Message Arrival Notifications in Outlook 2013/2016 
 

Enable the Junk Mail Filter 
Once you have reduced or eliminated the continuous interruptions generated by incoming email, the next 
problem to tackle should be junk mail. Make sure that the built-in Junk E-mail filter is enabled and set the 
level of junk email protection to "high." 

 
To enable the Junk E-mail filter, do one of the following. 

 
1. In Outlook 2007, select Tools, Options from the menu. In the Options dialog box, click Junk E-mail 

on the Preferences tab. In Outlook 2010-2016, select Junk, Junk E-mail Options on the Home tab. 
 

2. In the Junk E-mail Options dialog box, set the level of junk email protection to High and uncheck 
Permanently delete suspected junk e-mail instead of moving it to the Junk E-mail folder as 
shown in Figure 2. Click OK to save your changes. 

 
At this point, users should review their Junk E-mail folder daily to make sure that valid email has not been 
captured by the filter. Any time a valid email is filtered improperly, steps should be taken to alter the 
filter's actions. In Outlook 2007, right-click on the message and select Junk E-mail, Add Sender to Safe 
Senders List so that email from that sender won't be captured by the filter in the future. Then, select Junk 
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E-mail, Mark as Not Junk to move the message back to the Inbox. In Outlook 2010-2016, right-click on 
the valid message and select Junk, Never Block Sender or Never Block Sender's Domain. Then, select 
Junk, Not Junk to move the message back to the Inbox. 

 

 
Figure 2 - Enabling the Junk E-Mail Filter 

 
Similarly, when junk email gets through to your Inbox, make sure to update the filter to catch the junk in 
the future. In Outlook 2007, right-click on the message and select Junk E-mail, Add Sender to Blocked 
Senders List so that email from that sender won't escape the filter. In Outlook 2010-2016, right-click on 
the valid message and select Junk, Block Sender. Taking a few minutes to keep the junk filter up to date 
will pay big dividends in the long term. 

 
 

Triage the Inbox Rapidly 
The preceding tips eliminate or reduce junk email and the number of interruptions that most users 
experience on a daily basis, but they don't help us with the cumbersome and time-consuming task of 
clearing our Inbox or taking action on important message requests. The following tips and tricks are 
designed to help users triage their Inbox in rapid fashion. 
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Make the Message List Work for You 
The message list can be sorted in ascending or descending order along an array of pre-defined dimensions 
with just a few clicks from the top of the Message List. Messages can be sorted by date, category, subject, 
whether the message has attachments, or from whom the message was sent, etc. Messages can also be 
grouped within dimension to fit a particular circumstance. The groups can be expanded or collapsed 
individually or all at once. 

 
Several new features have been added to the Message List in Outlook 2013/2016 to make it easier for 
users to triage their Inboxes. The Message List in Outlook 2013 has filter buttons to display all messages 
or just unread ones, as shown in Figure 3. A single click rapidly filters the list to display the messages 
desired. Further, unread messages are identified by the colored bar on the left edge of the message 
header. In Outlook 2016, the same functionality is available from a drop-down menu at the top of the 
message list. 

 

Figure 3 – Easily Identify or Filter Unread Messages 
 

The Message List can be filtered to display only unread messages in earlier versions. In Outlook 2007, 
simply select Unread Messages in this Folder from the Current View box on the Advanced toolbar. If the 
toolbar is not displayed, select View, Current View, Unread Messages in this Folder from the menu. In 
Outlook 2010, click Filter E-mail on the Home tab and select Unread or click in the Search box at the top 
of the Message List and select Unread on the Search Tools, Search contextual tab. The Filter E-mail button 
can be added to the Quick Access Toolbar for convenience. 

 
In Outlook 2013/2016, the message header can be set to reveal from one to three lines of the message 
itself. This helps users focus their time on those messages that require their attention first. To set the 
number of message lines displayed in the message header, select View, Message Preview on the ribbon. 
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Mark as Read or Unread 

Delete Message 

Flag as To-Do Item 

In default, the Message Preview is set to display two message lines. For maximum impact, set it to three. 
On large monitors, widen the Message List so that more of the message is displayed in the preview. 

 

Figure 4 – Adjusting the Message Preview 
 

Message preview is also available in earlier versions of Outlook, but the preview is set at three lines. To 
turn on message preview in Outlook 2007, select Messages with AutoPreview from the Current View box 
on the Advanced toolbar. If the toolbar is not displayed, select View, Current View, Messages with 
AutoPreview from the menu. In Outlook 2010, click View, View Settings and then click Other Settings. In 
the AutoPreview section, select Preview all items or Preview unread items. Note that the preview can 
be configured to display for unread messages only, a feature not available in Outlook 2013/2016. The 
AutoPreview Layout button can be added to the Quick Access Toolbar for convenience. 

 
Messages can be acted upon directly within the Message List in Outlook 2013/2016 without resorting to 
the context-sensitive menu. Messages can be flagged for action, deleted, or marked as read or unread as 
shown in Figure 5. This is especially useful for those using touch devices. In Outlook 2013/2016, users can 
no longer categorize messages in the message header. 

 

Figure 5 – Action a Message within the Message List 



7 
Copyright © 2017, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 
 

Minimize Annoying Windows with In-line Reply and Forward 
In Outlook 2013/2016, users can now reply or forward a message directly from the Reading Pane. Click 
the desired action, and the Reading Pane becomes an editing pane with most formatting capabilities as 
shown in Figure 6. 

 

Figure 6 – Replying to a Message from within the Reading Pane 
 

For those requiring more formatting options than are normally available when composing a reply within 
the Reading Pane, users can Pop Out the message into a new window. While the message is being 
composed, "[Draft]" will be displayed in the message header. If a user moves away from the message 
before sending the response, the response will be accessible from the Drafts folder for further action, and 
the message header will continue to be marked "[Draft]" in the original folder. To delete a reply before 
sending, simply click Discard. 

 

Find Related Messages with Conversation View 
Business professionals often need to refer to an earlier message in a message thread to confirm an action 
request. One way to accomplish that goal is to find all related communications to a message of interest. 
In Outlook 2007, right-click on the message of interest in the Message List and select Find All, Related 
Messages. In Outlook 2010-2016, right-click on a message and select Find Related, Messages in this 
Conversation. In both instances, the process finds all related messages regardless of the folder in which 
the messages are filed. 
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Alternatively, email messages can be viewed by Conversation in Outlook 2010-2016. When Conversation 
View is enabled, messages in the Message List that share the same subject can be viewed in a single 
thread. Users can quickly review and act on individual messages or a complete Conversation. 
Conversations are identified in the Message List with a white arrow point. The messages within each 
Conversation are sorted with the newest message at the top of the expanded list. As new messages in the 
thread are received, the entire Conversation is positioned in the Message List in the date order currently 
active. When users click on a Conversation header in the Message List, the newest message in the thread 
is displayed in the Reading Pane. Any Conversation that contains unread messages has a bold subject in 
the message header along with a count of the unread messages in the thread. Expanded Conversations 
display any unread messages with a bold heading. In default, Conversations include all related messages 
regardless of the folder in which they are filed. For example, messages sent by a user are typically saved 
in the Sent Items folder, but will appear and be grouped in a Conversation with messages in the Inbox as 
shown in Figure 7. 

 

 
Figure 7 – Conversation Thread Expanded in the Message List 

 
When a message gets two or more responses, a Conversation can split into multiple but separate threads. 
In Outlook 2010, click on an individual message inside a split to display its Reply Line - a dashed line that 
shows the messages to which it replies. Reply Lines, as a feature, have been removed from Outlook 
2013/2016. 

 
To view messages in Conversations, the Message List must be arranged in date order. To enable 
Conversations in Outlook 2010-2016, check Show as Conversations on the View tab. Alternatively, click 
on the Arrange By (sort) drop-down at the top of the Message List and select Show as Conversations. 
Note that messages can be sorted by Conversation in Outlook 2007, but the resulting display only contains 
messages found in the current folder, which is much less powerful than the Conversation View found in 
Outlook 2010-2016. 

 

 By design, Conversations are grouped by subject. Messages with the same subject are grouped 
in a Conversation, even if the messages are unrelated. This may cause problems for some users 
who send or receive messages with commonly used subjects. 
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Automate Routine Mail Processes with Quick Steps 
Repetitive, multistep procedures can be converted to single clicks with Quick Steps in Outlook 2010-2016. 
Think of Quick Steps as a macro creation tool that allows users to automate the Inbox triage process. For 
example, if users forward messages to their managers frequently, the conventional process requires 
opening and addressing the forwarded message before adding comments to the message itself. A custom 
Quick Step can eliminate the first two steps in the process and possibly all three. Quick Steps are executed 
from the Quick Steps gallery on the Home tab. The first time a user executes one of the six pre-configured 
Quick Steps, Outlook prompts the user to specify any required details and rename the Quick Step, if 
desired, as shown in Figure 8. 

 

 
Figure 8 – Customizing a Quick Step on First Use 

 
To add additional actions or to customize the Quick Step beyond the simple customizations illustrated, 
click Options to open the Edit Quick Step dialog box as shown in Figure 9. To access all available options, 
click the Show Options link. In this case, notice that the subject, flag, and importance can be set along 
with a custom text message and a keyboard shortcut. More importantly, additional actions can be added 
to the Quick Step so that multistep processes can be accomplished with a single click. 

 
To edit an existing Quick Step, click the drop-down arrow in the lower right-hand corner of the Quick Step 
gallery and select Manage Quick Steps. 
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Figure 9 – Adding More Complex Customizations to a Quick Step 
 

Flag Messages for Follow-up 
When you receive a message that requires action, flag it for follow-up. In the message list, simply click on 
the flag icon in a message header to add the message to the Task List with the Due Date set to Today. 
Alternatively, right-click on the flag icon to select from several built-in follow-up periods or to create a 
custom due date as shown in Figure 10. Users can set the default due date to meet their needs by selecting 
Set Quick Click from the context-sensitive menu. 

 

Flagging a message for follow-up does not create a separate new Task item. It merely adds the flagged 
message to the Task List. If the task item is deleted from the Task List, the associated message is also 
deleted. This causes great frustration for users who routinely clear their Task List by deleting completed 
items because that process prevents them from finding or referring to previously actioned messages. 
Instead, mark an item complete by clicking the flag icon in the Task List. The flagged message will disappear 
immediately from the Task List but will remain in the Message List, marked with a green checkmark to 
indicate that action has been taken. Similarly, flagged messages can be marked complete directly from 
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the Message List. Simply click on the flag in a message header to change it to a green checkmark and 
remove the message from the Task List. 

 

 
Figure 10 – Creating a Task Item by Flagging a Message for Follow-up 

 
Users can also flag outgoing messages to remind recipients of some event or requested action. For 
example, if a report is due next Friday, a manager could send an email message to her subordinate 
reminding him of the due date. The manager could also flag the message to display a reminder to her 
subordinate on the date and time of her choosing. To flag a message for a recipient, click the Follow-Up 
button on the Message tab of the message window and select Flag for Recipients. 

 

Find Anything Quickly with Instant Search 
When you need to find messages related to specific issues or from specific people, don't scroll endlessly 
through your messages, or sort the message list on a sender's name; instead, use Instant Search. Just type 
a key word or a person's name in the search box at the top of the message list, and you will find what you 
are looking for in just a few seconds. Instant Search was introduced in Outlook 2007, but Outlook 2010 
and 2013/2016 make it easier and more intuitive for users to narrow their search results by adding search 
criteria. Whenever users click in the Search box at the top of the Message List, the Search Tools contextual 
tab is displayed as shown in Figure 11. Users can select from a wide variety of criteria – From, Subject, Has 
Attachments, etc. – and can select from a list of locations to search – All Mailboxes, Current Mailbox, 
Current Folder, Subfolders, All Mail Items, or All Outlook Items. If the desired criteria are not exposed on 
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the Search Tools contextual tab, click More for a complete list of search fields. The criteria for the ten 
most recent searches are maintained in the Recent Searches drop-down list. In Outlook 2007, criteria can 
be added by clicking the chevron arrow immediately to the right of the Search box. 

 

 

 
Figure 11 – Search Tools Contextual Tab 

 
Users can easily specify what locations to search with a drop-down menu just to the right of the Search 
box in Outlook 2013/2016 as shown in Figure 11. The Current Mailbox is the default search location. The 
default location can be modified in Outlook options. Click File, Options, Search to set the location of your 
choice. 

 
 

Don't Rekey – Use Drag-and-Drop 
Email messages often precipitate the creation of new tasks or appointments. Don't use the keyboard to 
create these tasks or appointments; use drag-and-drop instead. Simply drag a message from the Message 
List and drop it on the Calendar button to create a new appointment automatically. An added benefit is 
that the body of the message will be embedded in the body of the appointment so that any critical 
information or needed explanation is available at your fingertips in preparing for the meeting. 
Additionally, Outlook allows users to drag-and-drop all types of items to organize or create new items 
quickly and easily. Here are some of the most useful and timesaving ways in which users can organize 
their communications, calendar, and tasks. 

 

• Organize your messages by dragging them from the Message List and dropping them into other 
folders in the Folder List. 
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• Create new tasks by dragging messages to the Tasks button. The subject of the message becomes 
the title of the task, and the message body is contained in the task notes. 

 

• Create new or update existing Contacts by dragging messages to the Contacts button. The 
message body is added to the Notes field of the contact. Outlook will display any proposed 
updates to existing Contacts for user confirmation. 

 

• Create new appointments by dragging messages to the Calendar button. The subject of the 
message becomes the title of the calendar item, and the message is contained in the calendar 
notes. Alternatively, drag messages to the appropriate dates on the thumbnail calendars in the 
To-Do Bar to create new appointments on the dates chosen. This functionality has been removed 
in Outlook 2013/2016. 

 

• Create new email messages by dragging contacts to the Mail button. 

• Put tasks on your calendar by dragging tasks to the Calendar button. The title of the task becomes 
the title of the calendar item, and the task detail is contained in the item's notes. 

 

• Create reminder messages for appointments by dragging appointments to the Mail button. The 
title of the appointment becomes the subject of the message, and the calendar detail is included 
in the message body. 

 
These are just a few of the ways users can put drag-and-drop processes to work in Outlook. Almost any 
Outlook item can be used to create another Outlook item quickly and easily using this process. This 
functionality eliminates the need to rekey information and dramatically improves user productivity. 

 

Build a Complete Record 
Have you ever scheduled an appointment or task and then had to search for its related source documents 
when the task or appointment came due? Instead of working with multiple discrete items, use drag-and- 
drop to build a complete record when the appointment or task is scheduled. If an email message 
precipitates the task or appointment, create the item by dragging-and-dropping the message to the 
appropriate button. Then, drag documents and contacts into the body of the task or appointment as they 
become available. When the task or appointment comes due, all of the related supporting information 
and documentation will be in the body of the item, thereby saving time and effort. 

 

Figure 12 shows a task that was created by dragging a message to the Tasks button. Note how the message 
is included in the body of the task, which alleviates the need of the user to search for the original message. 
In building the complete record, all of the necessary files and the contact records for others involved in 
the process have been dragged into the task. When the task comes due, all of the needed documents and 
information will be readily available to the user. 
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Figure 12 - Build a Complete Record to Support a Task or Appointment 
 
 

Organizing the Inbox 

Using Folders to Organize 
Folders are the most widely used means for organizing email messages in the Inbox. From simple to 
elaborate schemes, folders are easy for users to understand and implement. The folder hierarchy can be 
as elaborate and complex as a user's needs dictate. The biggest problem with using a complex multi-level 
structure is finding messages in the labyrinth of folders, especially when a single message can be logically 
related to multiple folders. This was particularly problematic in older versions of Outlook, where the built- 
in search functionality only searched one folder at a time. This made finding messages a cumbersome, 
time-consuming process that often found users browsing the message lists folder-by-folder looking for an 
important communication. 

Original message. 

Embedded files and 
contact records. 
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In almost every circumstance, several custom folders will need to be created for storing and organizing 
messages. Be careful not to make your folder structure too deep or too complex. Here is a short list of 
folders commonly used by many experienced Outlook users. 

 

• Company Inbox – contains messages from other staff members within an organization; may 
contain sub-folders for departments, teams, or managers 

 

• Major Accounts – contains messages from major clients, customers, or vendors; may contain sub- 
folders for individual clients, customers, or vendors 

 

• Action/Hold – stores messages that require action 

• Personal – holds messages from a user's spouse, relatives, or close personal friends 

Using Categories to Organize 
Categories are a color-coding and tagging system to organize messages within folders and across multiple 
folders. Think of categories as virtual folders, similar in operation to labels in Gmail. With categories, there 
is no need to create a complex folder structure. Messages and other Outlook items can be assigned to 
one or more categories, which allow users to access these items quickly and easily by Group in the 
Message List or using a Search Folder. 

 

 
Figure 13 - Multiple Categories Can Be Assigned to a Message 



16 
Copyright © 2017, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 
 

[3] 

Outlook comes with a number of predefined categories, but users can customize the list to meet their 
own needs. Each category is associated with a user-specified color so that messages and items can be 
identified visually. 

 
To assign a category to a message do the following: 

 
1. In Outlook 2007/2010, right-click on the Category Box for the message of interest in the Message 

List and select the appropriate category. In Outlook 2013/2016, click the Categorize button on the 
Home tab as shown in Figure 13. 

 
To assign multiple categories to a message, repeat the process for assigning a single category as often as 
required. Alternatively, click All Categories, near the bottom of the category list, and check the categories 
to be assigned to the message or other Outlook item. 

 
To access categorized messages quickly, simply select one of the built-in search folders, Categorized Mail, 
from the folder list as shown in Figure 14. All mail that has been assigned one or more categories will be 
displayed in the message list within groups that can be expanded or collapsed to display the desired 
messages. Messages that have been assigned to more than one category will appear in each group to 
which they have been assigned. 

 

 
Figure 14 – View Messages in Categories as Virtual Folders 

 
All categorized messages will appear in their respective groups, regardless of the physical folders in which 
the messages reside. In other words, categories act as virtual folders, organizing messages across multiple 
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physical folders to provide quick and easy access to messages with some common characteristic. This 
functionality makes it easy for users to organize messages for later access, even when a single message is 
logically associated with two or more categories. 

 

Using Folders and Categories Together 
Folders and categories should be thought of as complementary tools that can be used together to organize 
your messages more effectively. For example, folders could be used to provide a simple high-level 
organizational structure, while categories could be used to provide additional levels of detail. While 
folders provide an intuitive organizational structure for most users, each message can only be stored in a 
single folder unless multiple copies of a message are made. Further, dealing with a complex folder 
structure reduces productivity. Categories overcome these disadvantages by allowing messages to be 
logically associated without the necessity of creating or maintaining a complex folder structure. 

 

Categories are best used to organize work. They provide visual cues to determine quickly and easily from 
or to whom messages were received or sent, the project or team with which they were associated, 
whether they're personal or business-related, or whether they are identified with any other important 
characteristic. They are especially useful for messages that require grouping across several characteristics. 
For example, a single message concerning a meeting with a key client may need to be organized by who 
requested the meeting, the type of engagement, and the staff member in charge. In this case, three 
categories could be assigned to the message without requiring a complex folder structure. 

 

Selectively Turning On Alerts 
An earlier tip described how to minimize interruptions by turning off all inbound email notifications in 
Outlook. Unfortunately, some of our cohorts, superiors, or clients demand immediate action on the 
messages they send us. With rules, we can selectively turn on email notifications for messages arriving 
from specific people. Start the rule creation process as described above. Then, choose Apply rule on 
messages I receive in the Start from a blank rule section of the Rules Wizard. Identify the sender(s) and 
then select the following actions when a message is received: 1) play a sound, 2) display a specific 
message in the New Item Alert window, and 3) display a Desktop Alert. Complete the rule as described 
earlier. After the rule is enabled, you will be notified by Outlook when a message arrives from an 
important person, even though message arrival notifications have been disabled. 

 

Keeping the Inbox Clean with AutoArchive 
A user's mailbox grows as items are created and received. As a mailbox grows larger, Outlook slows down 
in day-to-day operations, and the probability of data file corruption increases. To manage these potential 
problems, many users manually clean out old messages, tasks, and calendar items, but Outlook provides 
an automated process – AutoArchive – to handle this time-consuming task. AutoArchive is a mystery for 
many Outlook users. In default, AutoArchive runs every two weeks and moves all of the messages and 
other items that are older than six months to an archive folder – a .pst file located on a user's computer. 
While almost all users have seen the prompt from Outlook to run AutoArchive, most cancel the operation 
because they are not sure what the process entails. 

 
To set up AutoArchive properly requires three simple steps: 1) review and change the global settings to 
meet a user's needs, 2) apply the changes to all folders, and 3) customize the global settings for specific 
folders. 
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To change the global settings for auto-archive: 

 
1. From the menu, select Tools, Options to open the Options dialog box. 

 
2. On the Other tab, click AutoArchive. 

 
3. In the AutoArchive dialog box, review and modify the settings to meet a user's needs. 

 
In default, AutoArchive runs every fourteen days, archives all messages and items older than six 
months to a file named archive.pst, and deletes expired items. The expiration date for all 
messages and items is six months, except for Calendar items (which do not expire), Sent Items, 
and Deleted Items (which expire in 2 months). 

 
K2 Enterprises recommends that users uncheck Delete expired items (e-mail folders only). All 
other settings should be configured to meet the needs of individual users, as shown in Figure 15. 
 

 
 

Figure 15 – Setting AutoArchive Defaults 
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Note that the name and location of the archive.pst file can be modified in this dialog box if desired. 

Before closing the AutoArchive dialog box, make sure to apply the changes to all existing folders: 

1. Click Apply settings to all folders now. 
 

2. Click OK, OK to close the dialog box and complete the process. 
 

Now that the modified AutoArchive settings have been applied to all folders, the only task remaining is to 
customize the settings for individual folders as necessary: 

 
1. In the Navigation Pane, right-click on a folder for which the archive settings need to be 

customized and select Properties from the context-sensitive menu. 
 

2. On the AutoArchive tab, adjust the folder's archive settings as required, as shown in Figure 17. 
 

 
Figure 17 – Customizing the AutoArchive Settings for Individual Folders 

 
Among the folders that may require individual archive settings are Action/Hold, Company or Personal 
inboxes, InfoPath Form folders, and Calendar and Task folders. The Contacts folder is never archived. 
Follow along with your instructor as we explore AutoArchive. 
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Once AutoArchive runs, the Archive folder will appear in the Navigation Pane at the bottom of the folder 
list. Expanding the Archive folder will reveal a set of folders identical to those contained in a user's 
mailbox. As a message or item is archived, it is moved to the same location in the Archive folder. In other 
words, a message in the Company Inbox will be moved to the Company Inbox in the Archive folder during 
the archiving process. All messages and items in the Archive folders can be accessed just as any other 
messages or items in a user's mailbox. They can be searched with Instant Search, or moved to other folders 
in the archive or back to the main mailbox using drag-and-drop. The point is that users will have the same 
access to messages and other items that they have always had, notwithstanding that the messages and 
other items have been relocated to the Archive folder. The advantages gained are that a user's mailbox is 
smaller, opens faster and performs better, is less cumbersome to use, and is less likely to corrupt. 
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